Using OnBase
# Table of Contents

**Using OnBase** ................................................................. 1

**Starting OnBase** ............................................................ 3
  To start the OnBase desktop client: ............................................. 3

**Scanning Documents** ...................................................... 5
  Scanning Documents ................................................................. 5
  To scan a document: ................................................................. 5
  To change the batch name: ......................................................... 6
  If you want to add to this batch name: .......................................... 6
  If you want to create a brand new batch name: .............................. 6
  Once the scan has completed: ................................................... 6
  Selecting the Scan Format .......................................................... 6
  Scan Format ................................................................................. 7
  Paper Size .................................................................................. 7
  Purpose ....................................................................................... 7
  Completing the Scan ................................................................. 8
  Button ....................................................................................... 8
  Purpose ....................................................................................... 8

**Indexing Documents** ...................................................... 9
  To index a document: ................................................................. 9
  If more documents in the current document batch need to be indexed:...... 10
  For more information on using the indexing toolbar: ....................... 10

**Opening Documents** ..................................................... 11
  Retrieving Documents ............................................................. 11
  Open the Document Retrieval window: ........................................ 11
  Select the Document Type: ......................................................... 11
  Find the document: ................................................................. 11
  Open the document: ................................................................. 11
  Search by Index Date ................................................................. 11
  To search for documents by specific index date: .......................... 11
  To choose a From and To index date using the calendar: ............... 12
Using OnBase

To search for documents by month: ................................................................. 12
To search for documents relative to the current date: ...................................... 13

Search by Keyword .............................................................................................................. 13
To search for a document by keyword: ................................................................. 13
To search for a document by keyword when you do not know the full keyword: ................................................................. 13
To search for a document using multiple values for the same keyword type: ................................................................. 13

Using Operators ................................................................................................................... 14
To create a new entry for a keyword type: .......................................................... 14
To combine multiple keyword values: ................................................................. 14
Operator Purposes .................................................................................................. 15
Operator ................................................................................................................... 15
Allowed Values ........................................................................................................ 15
Purpose ..................................................................................................................... 15

Using Wildcards .................................................................................................................... 15
To use a wildcard in your keyword search: ......................................................... 15

Opening Documents ............................................................................................................ 16
To view a document: .............................................................................................. 16

Modifying Documents ...................................................................................................... 17

Copying Pages to Existing Documents ............................................................................. 17
If both documents have been indexed: ........................................................................ 17
If one document has not yet been indexed: ........................................................ 17
Copy the pages to the other document ........................................................................ 17

Scanning More Pages ...................................................................................................... 18
To add new scanned pages to a document: ........................................................ 18
Once the scan has completed: .............................................................................. 18

Copying Pages into New Documents ............................................................................... 19
To copy a page into a new document: ................................................................. 19

Zooming ................................................................................................................................ 20
To zoom in on a document................................................................................... 20
To zoom out: ........................................................................................................... 20
To fit the view to the width of the document .................................................... 20
To view the whole document ............................................................................... 20

Using Post-it Notes .............................................................................................................. 20
Table of Contents

To create a new note: ................................................................. 20
Searching Notes ............................................................................... 21
  Open the Document Retrieval window: ........................................... 21
  To search for notes: ................................................................. 21
Changing a note ............................................................................... 22
  To change the text of a note: ...................................................... 22
Viewing Document Histories .............................................................. 23
  To view a document's history: .................................................... 23
  To create a plaintext report of a document's history ...................... 23

Saving Documents to Your Computer ............................................ 25
  To save a document to your computer: ........................................ 25

Printing Documents ....................................................................... 27
  To print an entire document: ..................................................... 27
  To print a selected area of a document: ....................................... 27

Glossary ...................................................................................... 29

Index .......................................................................................... 31
Using OnBase

Welcome to the user guide for BGSU’s OnBase desktop client. This guide covers the most frequently performed tasks in the OnBase system, including scanning, indexing, opening, modifying, and outputting documents.
Starting OnBase

To start the OnBase desktop client:

1. Double-click on the OnBase icon found on your desktop, as shown below.

   ![OnBase Icon](image)

   **The OnBase Desktop Icon**

2. In the following login screen, enter your OnBase user name in the user name text box.

3. Enter your OnBase password in the password text box.

4. Left click on the **Login** button.
Scanning Documents

To scan a document:

1. Start OnBase.
   - For more information on starting OnBase, see Starting Onbase.
2. Click on the Processing menu, then click Scan/Index.
   - This will open the Document Imaging window.
3. Left click on Scan Queues in the top left panel of the Document Imaging window
   - This will open the Scan Queues panel to the right, as shown below.

<table>
<thead>
<tr>
<th>Scan Queue</th>
<th>Scan Format</th>
<th>Scanner Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>CEE Budgets_Operations</td>
<td>No Format Specified</td>
<td>Unavailable</td>
</tr>
<tr>
<td>DOS Discipline Files</td>
<td>No Format Specified</td>
<td>Unavailable</td>
</tr>
<tr>
<td>Facilities</td>
<td>No Format Specified</td>
<td>Unavailable</td>
</tr>
<tr>
<td>OS Departmental</td>
<td>No Format Specified</td>
<td>Unavailable</td>
</tr>
</tbody>
</table>

4. In the right panel of the Document Imaging window, double click on the scan queue needed.
5. Select the scan format from the Scan Format drop-down list
   - For more information on Scan Formats, see: Selecting Scan Format.
6. Insert the document page or pages into your scanner.
   - For more information on how to use your scanner, see your scanner's manual.
7. Left click on the Scan button.
   - The Batch Name dialog will open.
To change the batch name:

The OnBase system will automatically provide a batch name consisting of your OnBase user name followed by the current date.

If you want to add to this batch name:

1. Click on the end of the name in the text box.
   - The auto-generated name will no longer be highlighted.
2. Type your addition to the name.
3. Click the OK button.

If you want to create a brand new batch name:

1. Type in the desired name.
2. Click the OK button.

Once the scan has completed:

1. In the Scanning Complete dialog box, left click on the Done button.
   - For more information on the options in the Scanning Complete dialog box, see Completing the Scan.
2. The document batch will be placed in the Awaiting Index folder.

Selecting the Scan Format

The Scan Format drop-down list

The Scan Format drop-down menu determines the size, orientation, and number of resulting documents for each scanning session. The following table lists each option, along with its paper size and purpose.

Note: Depending on your scanner type and department, you may not have all options listed.
<table>
<thead>
<tr>
<th><strong>Scan Format</strong></th>
<th><strong>Paper Size</strong></th>
<th><strong>Purpose</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Flatbed</td>
<td>8½&quot; × 11&quot; or irregular</td>
<td>Scanning irregular, smaller, damaged, or delicate documents.</td>
</tr>
<tr>
<td>Multiple</td>
<td>8½&quot; × 11&quot; or smaller Portrait</td>
<td>Scanning pages as multiple documents</td>
</tr>
<tr>
<td>Multiple (Landscape)</td>
<td>8½&quot; × 11&quot; or smaller Landscape</td>
<td>Scanning pages as multiple documents</td>
</tr>
<tr>
<td>Multiple (Legal)</td>
<td>8½&quot; × 14&quot; or smaller Portrait</td>
<td>Scanning pages as multiple documents</td>
</tr>
<tr>
<td>Single</td>
<td>8½&quot; × 11&quot; or smaller Portrait</td>
<td>Scanning pages as a single document</td>
</tr>
<tr>
<td>Single (Landscape)</td>
<td>8½&quot; × 11&quot; or smaller Landscape</td>
<td>Scanning pages as a single document</td>
</tr>
<tr>
<td>Single (Legal)</td>
<td>8½&quot; × 14&quot; or smaller Portrait</td>
<td>Scanning pages as a single document</td>
</tr>
<tr>
<td>Transcripts</td>
<td>Transcripts</td>
<td>Scanning transcripts</td>
</tr>
</tbody>
</table>
Completing the Scan

The Scanning Complete dialog box

After scanning finishes, OnBase will display the Scanning Complete dialog box. Using this box, you can complete the scanning session, or make changes to your scanned documents. The chart below describes the purpose of each button.

<table>
<thead>
<tr>
<th>Button</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scan More Pages</td>
<td>Continue adding pages to current batch or document</td>
</tr>
<tr>
<td>New Document</td>
<td>Create a new document within batch</td>
</tr>
<tr>
<td>Change Format</td>
<td>Modify the current format before continuing</td>
</tr>
<tr>
<td>Discard Pages</td>
<td>Discard scanned pages</td>
</tr>
<tr>
<td>Done</td>
<td>Scanning complete</td>
</tr>
<tr>
<td>Delete Last Page</td>
<td>Delete the last page and continue</td>
</tr>
<tr>
<td>Delete Last Document</td>
<td>Delete the last document and continue</td>
</tr>
</tbody>
</table>

Scanning additional pages using the current settings

Scanning additional pages as a new document

Changes the scan format for additional pages scanned

Deletes all pages scanned to that point

Ends the scanning session.

Deletes the last page scanned

Deletes the last document scanned
Indexing Documents

Once a document has been scanned, it needs to be indexed. Indexing allows the document to be easily retrieved by setting important keywords.

To index a document:

1. Start OnBase.
   - For more information on starting OnBase, see Starting OnBase.
2. Click on the Processing menu, then click Scan/Index.
   - The Document Imaging window will open.
3. In the top left panel of the Document Imaging window, click on the Awaiting Index folder.
4. Click on a document batch in the Scanned Batches panel to the right.
5. Right click on the batch then click Index Documents.
6. The Scanned Batches panel will display an image of the first document.
Right clicking on the batch in the Scanned Batches panel

7. Select the type of document in the **Document Type** drop-down list.
8. Enter document information into the individual fields in the **Keyword** section.

**Note:** The number and type of keyword fields will vary based on the document type.

9. Click on the **Index** button.

If more documents in the current document [batch] need to be indexed:

Repeat steps six through eight for each additional document.

For more information on using the indexing toolbar:

See: Using the Indexing Toolbar
Retrieving Documents

Retrieving Documents

Retrieving and opening documents takes four main steps.

Open the Document Retrieval window:

The Document Retrieval window is open by default when OnBase is started. If the window is not open click on the File menu, then the Open submenu, then Retrieve Document.

Or

Click on the Retrieve Documents icon in the main toolbar.

Select the Document Type:

1. Select the document type group in the Document Type Groups list box at the top of the Document Retrieval window.
   - The Document Types list box will display the document types in that group.
2. Select the document type in the Document Types list box.

Find the document:

- To search by index date, see: Search by Index Date
- To search by keyword, see: Search by Keyword

Open the document:

- To open the document, see: Opening Documents

Search by Index Date

To search for documents by specific index date:

1. Enter dates into the From and To text boxes.
2. Click the **Find** button.

To choose a From and To index date using the calendar:

1. Click on the **Calendar** button next to the text box.
2. The Calendar box will appear next to the text box, as shown below.

To search for documents by month:

1. Click on the Expand button in the top right corner of the Dates section.
   - The area will expand to show the advanced date options.
2. In the left list box, click on the first month and year to be searched.

To search by month list box

3. Left click on the last month to be searched.
4. The From and To text boxes will be filled in automatically.
5. Click the Find button.

To search for documents relative to the current date:
1. Click on the Expand button in the top right corner of the Dates section.
   - The area will expand to show the advanced date options.
2. In the right list box, select the time period to be searched.
   - The From and To text boxes will be filled in automatically.
3. Click the Find button.

Search by Keyword

To search for a document by keyword:
1. Enter the keywords into the fields in the Keywords section of the Document Retrieval window.

   Note: The number and type of keyword fields will vary based on the document type.

2. Click on the Find button.

To search for a document by keyword when you do not know the full keyword:
   See: Using Wildcards

To search for a document using multiple values for the same keyword type:
   See: Using Operators

Searching for a document using multiple values for the same keyword type.
Using Operators

You can search for a document using multiple values for a keyword type.

Searching for more than one year keyword.

To create a new entry for a keyword type:

1. Left click in the text box for that keyword.
   - A new text box for that keyword will be created.

Or

Double click on the keyword name next to the text box.

To combine multiple keyword values:

1. Duplicate a keyword using the methods shown above.
2. Enter the search terms into the keyword boxes.
3. Left click on the operator button next to the topmost copy of that keyword type.

The operator button
### Operator Purposes

<table>
<thead>
<tr>
<th>Operator</th>
<th>Allowed Values</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>OR</td>
<td>Any</td>
<td>Retrieves documents containing keywords that match one or more of the values entered for that keyword type.</td>
</tr>
<tr>
<td>AND</td>
<td>Any</td>
<td>Retrieves documents containing keywords that match all of the values entered for that keyword type.</td>
</tr>
<tr>
<td>TO</td>
<td>Numerals or dates</td>
<td>Retrieves documents containing keywords between the values entered for that keyword type.</td>
</tr>
</tbody>
</table>

### Using Wildcards

Keyword Wildcards allow you to search for a keyword even if the full keyword isn't known.

To use a wildcard in your keyword search:

- Use the * symbol to replace unknown letters or numbers.
  - For example: if you are searching for the name "Jane Roberts", but only know "Jane" and "Rob", enter **Jane Rob* to search for all names beginning with "Jane Rob".
Opening Documents

The Document Search Results window

OnBase will list the documents matching your search terms in the Document Search Results window.

- If there is only one document found, it will be opened automatically.
- A list of all searches made will be shown in the left panel of the Document Search Results window. This list is cleared every time you log out of OnBase.

To view a document:

Double click on the document name in the Document Search Results window.
Modifying Documents

Copying Pages to Existing Documents

OnBase can be used to move pages from one document to another.

If both documents have been indexed:

1. Retrieve and open the document you plan to add pages to.
   • For more information on opening documents, see Retrieving Documents.
2. With the first document still open, retrieve and open the second document.

If one document has not yet been indexed:

1. Retrieve and open the document you plan to add pages to.
   • For more information on opening documents, see Retrieving Documents.
2. With the first document still open, left click on the Processing menu, then Scan/Index.
3. Left click on the Awaiting Index folder in the Document Imaging window.
4. Under the Scanned Batches column, double click on the document batch you just scanned.
5. Double click on the document containing the pages you wish to add.
   • The document will open in a new window.

Copy the pages to the other document

1. Left click on the Window menu, then Tile Vertically.
   • The two documents will expand until each fill half of the OnBase client, side by side.
2. Find the document you are moving pages from.
3. Right click and hold on the **thumbnail** of the first page to be moved.
   - The mouse pointer will change to the **Move Page** symbol.
4. Drag the page to the thumbnails section of the document you are moving pages to.
   - A red line will appear between page thumbnails indicating where the new page will be placed.
5. Release the right mouse button to place the new page.
6. Repeat steps three through five to place additional pages.
7. When all pages have been placed, close both documents.

**Scanning More Pages**

**To add new scanned pages to a document:**
1. Open the document to be appended
   - For more information on opening documents, see **Retrieving Documents**.
2. Right click anywhere on the document image and select **Scan More Pages**.
   - The Document Imaging window will open, with the image of the document in the right panel.
3. Select the scan format from the Scan Format drop-down list
   - For more information on Scan Formats, see: **Selecting Scan Format**.
4. The **Scan More Pages** dialog box will open.
5. Click the **Scan** button.
6. Select where the new pages will be added.
7. Click **OK**.

**Once the scan has completed:**

In the Scanning Complete dialog box, left click on the **Done** button.

- For more information on the options in the Scanning Complete dialog box, see **Completing the Scan**.
- The new pages will be added to the document.
Modifying Documents

Copying Pages into New Documents

To copy a page into a new document:

1. Open the document.
   
   - For more information on searching and retrieving documents, see Retrieving Documents.

2. Right click anywhere in the image of the document, select the Send To submenu, then click on Create New Document.
   
   - The Create new document from existing dialog will open.

3. Select the Document Type of the new document.

4. Enter the page numbers to be turned into a new document into the Create from pages text box.

5. Fill in the keywords of the new document.

6. Click OK when finished.
   
   - A new document will be created using the selected pages.
Zooming

To zoom in on a document

Click on the **Zoom In** button in the toolbar.

Or

1. Left click and hold on the area of the document you wish to enlarge.
2. Move the mouse until the bounding box encloses the area you wish to enlarge.

To zoom out:

Click on the **Zoom Out** button.

To fit the view to the width of the document

Click on the **Fit Width** button.

To view the whole document

Click on the **Fit Window** button.

Using Post-it Notes

To create a new note:

Click the **Add Note** button on the main toolbar.

Or

1. Right click anywhere on the image of the document, select the Notes submenu, then click Add Note.
2. Choose the note type in the Add Note dialog box.
3. Click OK.

• An open note will be created on your document.
4. Type the desired note text into the white section of the note.

5. Click on the hide button to save and hide the note contents.
   - The note will be displayed on the document using the note icon.

Searching Notes

Open the Document Retrieval window:

The Document Retrieval window is open by default when OnBase is started. If the window is not open click on the File menu, then the Open submenu, then Retrieve Document.

Or

Click on the Retrieve Documents icon in the main toolbar.

To search for notes:

1. Select the document type group in the Document Type Groups list box at the top of the Document Retrieval window.
   - The Document Types list box will display the document types in that group.

2. Select the document type in the Document Types list box.

3. Click the Note Search button at the bottom of the Document Retrieval window.
   - The Note Text Search dialog box will open.

4. Enter the word or words to be searched for in the Search Text text box.

5. Enter date info in the Dates section if needed.

6. Choose the note owner in the Note owner drop-down list.

7. Choose the Note Type in the Note Type drop-down list.

8. Click Find.
   - Results will be displayed in a new window.

9. Double click on a result to view the document.
Changing a note

To change the text of a note:

1. Double click on the note icon on the document.
2. Change the current text of the note as desired.
3. Press the hide button to save and hide the note contents.
Viewing Document Histories

Document histories show records of when and who has created, changed, and viewed a document. A simple plain text report can be generated from this list.

To view a document's history:

1. Retrieve the document.
   - For more information on searching and retrieving documents, see Retrieving Documents.
2. With the Document Search Results window open, right click on the document and select History.
   - The Document History window will open.

To create a plaintext report of a document's history

Right click in the main list of the Document History window, then click Generate Report.
Saving Documents to Your Computer

OnBase documents are stored on a central server. However, you can save a copy of a document to your computer for access anytime.

To save a document to your computer:

1. With the document you wish to save open, left click on the File menu and choose Save As.
   - The Save As dialog box will open.
2. Choose the folder where the document will be saved.
3. Enter a filename for your document.
4. Choose a file format for the document using the Save as type drop-down menu.
5. Left click on the Save button.
Printing Documents

To print an entire document:

Left click on the Print button in the toolbar.

Or

Right click on an open document and select Print Document.

To print a selected area of a document:

1. Press and hold the CTRL key and left click and hold the mouse cursor in the area you wish to print.
2. Drag the mouse over the area.
   - A bounding box will appear containing the area to be printed.
3. Release the left mouse button.
   - A menu will appear at your mouse pointer.
4. Left click on Print selected, as shown below.
The Print Selected bounding box and menu
Glossary

B

batch: A group of one or more documents scanned together in one session.

C

Copy of redact: To hide information in a document by covering it with solid black.

D

document imaging: the online storage, retrieval, and management of electronic images of documents.
document type: A category in which documents with similar characteristics, for example purpose or department name, are grouped.

F

file format: The type of file, usually determined by purpose and listed by its extension. Examples include jpeg image (.jpg), word document (.doc), or portable document format (.pdf)

I

index: Defining attributes of a document, for example title, author, or date, in order to better organize that document.

K

keyword: An identifying piece of information used to locate documents stored in the OnBase system.

L

landscape: the method of printing or scanning in which the longer edge of the paper is used as the top of the printed page.

N
note: A comment or reminder attached to a document through a small window that will be displayed when the document is viewed.

O

OCR: Optical Character Recognition (OCR) is the process in which scanned document images can be translated into editable text.

Optical Character Recognition: Optical Character Recognition (OCR) is the process in which scanned document images can be translated into editable text.

P

portrait: The method of printing or scanning in which the short edge of the paper is used as the top of the printed page.

T

thick client: The full-featured desktop version of the OnBase client.

thin client: The simplified web version of the OnBase client that requires no installed software and can be used from any computer. Not covered in this reference guide.

thumbnail: A smaller version of the image of a document, showing the entire document page.

W

wildcard: A character used to represent one or more characters not specified in a search.
# Index

**A**
- Append
  - existing documents ...................... 17, 18
  - while indexing ................................. 9

**B**
- Batch Name dialog .............................. 5

**D**
- Document Imaging window ........................ 5, 9
- Documents
  - indexing ............................................. 9
  - modifying ........................................... 17, 18, 19, 20, 21
  - opening ............................................. 15
  - printing .............................................. 27
  - retrieving ......................................... 11
  - saving .............................................. 25
  - scanning .......................................... 5, 6, 7, 18

**F**
- File type ............................................. 25

**H**
- Histories ............................................. 23

**I**
- Indexing .............................................. 9
  - date ................................................ 11
  - documents ......................................... 9

**K**
- Keywords ............................................. 9
  - changing ........................................... 9
  - searching by ..................................... 13

**M**
- Modifying documents ............................. 17, 18, 19

**N**
- Notes
  - adding .............................................. 20
  - changing ........................................... 21

**O**
- OnBase ................................................ 3
- Opening documents ............................... 15
- Operator .............................................. 13

**P**
- Pages
  - appending......................................... 18
  - scanning more .................................... 18
  - separating into new documents ........... 18
- Paper Size ........................................... 6
- Print ................................................. 27
- Processing menu .................................... 5

**R**
- Retrieving documents ............................ 11

**S**
- Saving documents ................................ 25
- Scanning
  - completing ....................................... 7
  - document .......................................... 5
  - format ............................................. 5, 6
  - more pages ....................................... 18
- Searching .......................................... 11, 13, 15
  - by index date ................................... 11
  - by keyword ....................................... 13

**W**
- Wildcard ............................................. 15

**Z**
- Zoom ................................................... 19